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Book Descriptions:

create a manual in word 2013

Using Microsoft Word 2007s features makes part of the development process easier. Before you
begin to write, do some planning. Decide what tasks your employees need to accomplish and what
can be written down to help them. Plan on wear you will be using the training manualin a facetoface
class or a selfguided tour. Once you have an idea of what type of manual you are going to need, here
are some of the features you can use to make your idea a reality. This process will help you decide
how long your manual is going to be and help with breaking down jobs into smaller chunks, which
are easier to explain to a new employee. In the Paragraph group, there are three buttons bullets,
numbers and multilevel lists. You can also come up with your own. Write your outline for your
manual.Headers and footers are visual references for the employee to know where they are in the
training material. When you are doing training, adding page numbers helps you refer to certain
pages as well as certain subjects. The Header appears on each page of your manual, or you can
choose to have it appear on opposite pages if you want your manual to be more booklike. Footers
appear at the bottom of the page and are generally used for page numbers, dates, and ownership
information.You will see a number of cover page styles to choose from or you can create your own.
Give your training manual a descriptive title; include the date created and the authors, since often
training manuals are a group effort. This will also help visually organize your document for ease of
use by your employee. Create Heading styles for each section of your document by using the outline
you created this is not the same as a Header, which goes at the top of the page. Heading styles are
font styles you use to indicate the different sections in your training, as well as the different
subsections. In the styles section, you will see a number of different styles you can choose from
including Heading 1, Heading 2, Subtitle,
etc.http://riggi.ru/userfiles/ford-focus-cabriolet-owners-manual.xml
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Select the text for your Heading 1 and click on the Heading 1 style to indicate its importance in your
outline. Click on the next section of your outline to make a Heading 2. Go through your entire
outline, selecting Heading 1 and Heading 2. These will be included in your table of contents when
you are done. If you already added Heading 1 and 2s to your document, have Word do the work of
creating the TOC for you. You will see a list of the automatic tables you can use. Click on one of the
automatic selections and your TOC should appear, using the Heading styles from your outline. The
final and most essential section of the manual is the index. The more complete your index is, the
more your student will be able to search for answers by page number and topic afterward. To create
an index, highlight the word you wish to put in the index.While these suggestions are written for
Word 2007, you can do the same functions in Word 2003. Microsoft Word’s templates provide the
framework, allowing you to concentrate on the presentation of information about your product or
service. While working within one of Word’s templates, you have the freedom to customize the
document to your needs. Step 1 In Word, click the “File” tab and select “New.” Doubleclick the
“Books” folder in the “Available Templates” window. Doubleclick the “Other books” folder.
Doubleclick the “Professional manual” template. Word’s user manual template is just a starting point
as you customize the manual to your requirements. The document downloads into a new Word
window. Step 2 Scroll through the pages of the user manual template to get an idea of what’s
included, what needs to change, and what needs to be added. For example, Word includes a generic
title page, table of contents, headers, text blocks, and image placeholders, along with tips on user
manual setup. Step 3 Highlight a header or block of text. Type over it with your manual
information.http://stvorki.ru/files/ford-focus-change-manual-transmission-fluid.xml

Youll probably copy existing text from another document and paste it directly into the template text
boxes. Replace all of Word’s placeholder text with your own. Fill the manual as required; you may
want to add the text first, then the headers and images, or you may want to work linearly from the
first page through the end. Step 4 Rightclick a placeholder picture or image and click the “Delete”
key to remove it. To add your images, click the “Insert” tab, then the “Picture” button. Browse to the
image and doubleclick it. This is also an ideal way to brand the manual by adding your company logo
on the cover page and elsewhere in the document. Step 5 Click the “Home” tab. Check the options in
the Styles section of the ribbon. These dictate how sections of your manual appear, such as the main
paragraph text and the headings. This is a great way to ensure your manual conforms to your
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companys internal style requirements. Step 6 Scroll to the first page of the template, which is the
cover in most templates. Make sure all placeholder text has been replaced with information about
your product or service. Step 7 The table of contents shows the generic template headers. Rightclick
the table of contents and choose “Update Field.” Click the “Update entire table” radio button, then
click “OK.” This changes the table of contents to reflect your new headers and page numbers. Click
the “File” tab and select “Save As.” Enter the user manual’s file name in the “File name” field,
choose where to save the document on your computer, and click the “Save” button. For example,
you may prefer single pages to booklet style. In the former case, you can stick with Words default
page setup of 8.5 inches by 11 inches. Other Word templates use multipage layouts in other sizes
and orientations. Writer Bio Fionia LeChat is a technical writer whose major skill sets include the
MS Office Suite Word, PowerPoint, Excel, Publisher, Photoshop, Paint, desktop publishing, design
and graphics.

From fixing your old devices to catching up on recent techtrends, weve got you covered. Topics
Internet Media Printer Social Media Smart Devices Email Network Hardware Phone Software Legal
About Us Accessibility Terms of Use Privacy Policy Copyright Policy CA Do Not Sell My Personal
Information. Accessibility Accessibility Audits VPAT Evaluation Services Accessibility Remediation
Accessible PDF Remediation Services Accessible Website and Application Development Accessibility
Training Accessible Elearning Accessibility in the News Custom Elearning Elearning Philosophy
Accessible Elearning Managed Learning Services Training Support for Business Training Staff
Augmentation Services Learning Management System Mlearning Development Examples of Our
Work The Learning Dispatch Blog Classroom Training Course List Course Schedule Classroom
Rental Training FAQ Software Tips Blog About Government Solutions Blogs Team Career
Opportunities Community Involvement History Newsletter Subscriptions News and Media
Accessibility Statement Open Search Field Enter your text here. This week, our Microassist Software
Tips tutorial shows you how to create a table of contents for your long Word documents, helping
both you and your readers navigate your work. If you often work with long documents, don’t miss
Split Window View Work with Two Sections of the Same Word Document at Once. Using Headings to
Designate Sections of Your Document Before you create a table of contents for your document, it’s
important to separate your content into small, easily consumable sections. Each section should focus
on one or two concepts. This will allow you to provide clear, focused, and concise explanations.
Readers appreciate when they can identify when you’re moving to a new concept. Once you’ve
identified your sections, you can create your table of contents. An automatically generated table will
show the page number where each section begins.

Word 2013 builds your table of contents based on the headings you identify with heading styles. A
style is a predefined combination of font attributes, including color and size, that can be applied to
any text in your document. To apply a heading style, highlight the text you want to be your heading.
Then choose the desired heading option in the Styles group on the Home tab. Heading 1 is usually



for your main title, and Heading 2 and Heading 3 are for your subheadings. After applying headings
throughout your document, you are ready to create your table of contents in Microsoft Word.
Inserting a Table of Contents Based on Headings To insert a table of contents Insert a blank page at
the top of your document. Select the References tab on the ribbon. In the Table of Contents group,
click the Table of Contents button The first two Automatic Table options will use your headings to
create the table of contents. The Manual Table allows you to manually identify each section
regardless of the heading content. Choose the option that works best for your document. Your table
of contents will appear on the blank page you added to the beginning of your document. Now both
you and your readers can quickly determine which page to navigate to from your table of contents.
NOTE Be sure to update your table of contents anytime you make changes to your headings. Doing
so is quite simple Rightclick anywhere in the table and select Update Field from the menu. You can
choose to update only the page numbers for instance, if you added content to a section or you can
update the entire table. You’ll need to do the latter if you’ve changed heading names or added new
headings. Additional Productivity Resources To learn about upcoming classes on Word, please visit
our Course Schedule page. To schedule a custom class for any Microsoft application on your
organization’s campus, please contact our Training Team. Finally, be sure to look through our other
Software Tips for more on Microsoft Office.
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Remediation Services Accessible Website and Application Development Accessibility Training
Accessible Elearning Accessibility in the News Custom Elearning Elearning Philosophy Accessible
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Services Learning Management System Mlearning Development Examples of Our Work The
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FAQ Software Tips Blog About Government Solutions Blogs Team Career Opportunities Community
Involvement History Newsletter Subscriptions News and Media Accessibility Statement Search
Search. I need to know if there is a function You can follow the question or vote as helpful, but you
cannot reply to this thread.The link is automatically created for you.YOu simply have to click on the
desired heading to jump to that location in the document. No need to go to the TOC. The standard
ways, taught in most classes, force you to format your document in a way that suits Word. We’ll
show you how to get a Table of Contents TOC from a document formattedAnd, 10 tips about Word
tables of contents.Last updated 24 June 2010.This tip demonstrates how easy it is to create a TOC
based on the headings in your document. Changing how that table of contents looks is also easy,
provided you change the styles that Word automatically applies to the parts of the TOC. If you want
the page numbering to remain constant, then you’ll appreciate the advice in this tip. Most time and
money needs to be spent on product development and setting up the sales channels.

http://hilalbaskul.com/images/community-employment-project-operation-manual.pdf


http://precisionheavyhaul.com/images/community-first-aid-safety-manual.pdf

He knows that there are some legal requirements for the content of the manual and he wants a well
designed and userfriendly instructional manual that contributes to a good customer experience. I
decided to walk him through the entire process and developed an instruction manual template for
him. Here’s what happened. The results are as follows Although Philip used one of our paid
templates, I have made a free template that you can use to achieve exactly the same results. There is
only one difference. We have developed user manual templates for machinery, toys, medical devices
and electronics that contain all legal content. I provided him with some general information about
user instructions and with some good examples of existing user manuals. A good user manual assists
users on how to use a product safely, healthily and effectively. A welldrafted user manual only
provides that information that is relevant for the intended user of the product. A good user manual
should answer HOW and WHAT questions. They should contain information about what happens if a
task is not done correctly. Typical user types are the enduser, installer, maintenance engineer and
operator. Each user type needs a different approach in terms of language to be used, the tone of
voice and provided conceptual information. A product can be a system, tool, device, an instrument, a
piece of software or an app. Depending on the type of product, a user manual might include things
as The template contains all the information and more from the list above. It complies with the
requirements for his product. The user manual template is an MS Word document that can be
printed or placed online. Each tool has its own advantages and disadvantages. I will mention the
most common tools below Through the following links you can download a user manual sample for
documentation Let’s dive into the details and actions. This can be done by creating a user profile,
also named a persona.

This is not only useful for creating your user instructions, but it is an essential element at the start of
the development of any product. As an educated industrial design engineer, this is how we started
all our design assignments. That’s why I asked Philip to define his users and answer questions like
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What describes the user I asked Philip to fill out the template. Please note that the second tab also
contains Philip’s answers, so you have an example of how the sheet could be used. So if you want to
take defining your user one step further, I would suggest you visualise your user in the form of a
persona. When creating a persona you are giving your user a name, age et cetera, so it becomes a
real person that represents your user. This is the result Typical problems might include installing the
product, using the product, using the product safely, maintaining the product and disposing of the
product. In order to do so, I created another template for Philip. In the left column of the Lifecycle
tab, the stages of a product’s lifecycle are mentioned. These are derived from the international
standard for user instructions, the IEC 82079. Our user manual templates are compliant with this
standard. In other words Philip has defined the topics for his user manual. Each topic can only be
about one specific subject, has an identifiable purpose, and must be able to stand alone. A user
wants to solve one problem at a time.It can be a chapter or a subparagraph. As soon as a user is
looking for an answer to his problem, he will use the table of contents to find out how to navigate to
that answer. Start numbering PREPARATION PRODUCT FOR USE with number 4. We will add some
more chapters in the next step. The ToC is the outline of your user manual.The headings are the
subtitles that precede the actual text. They appear in the ToC, so the user can navigate to the
needed information. A thirdlevel heading uses nounphrases e.g. Packaging contents and Tools to be
used .
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The heading Making Pancakes is much more useroriented than Using the MagicCook5000. If the
section covers the maintenance and repair of a product, the heading Maintenance would be
incomplete. Pro tip when there is a Declaration of Conformity available already, you can find the
applicable directives in there. If the product is too small this can be placed in the user manual. If the
product is too small this can be placed in the user manual. Safety information shall be provided in
order to inform the user of measures to be taken. This standard has been harmonised in the EU.
Compliance with harmonised standards provides a presumption of conformity with the
corresponding legislation! Without removing and mandatory elements of course. Notice! Do not
adjust the Table of Contents. The table of contents can be updated automatically once you have
adjusted the section headings. And once you have determined the intended use, you can focus on
providing only those safety and user instructions for how to use the product within the given
envelope. If the defectiveness of a product needs to be determined, all circumstances will be taken
into account. That includes the reasonably foreseeable use of the product. For example, if a cooling
system is only used for cooling certain medications, then only these procedures need to be
described. When it could reasonably be foreseen that the cooling system may be used as a system to
cool organs, this should be described in the instructions. By doing so, you, as the manufacturer, will
limit your liability and you can focus on only describing how to use the system to cool medicines. A
risk analysis can also be mandatory for certain product groups, such as lowvoltage equipment, toys,
machinery and equipment for use in explosive atmospheres. The ISO 12100 also gives a method for
taking mitigation measures the ThreeStep Method. According to this method, there is the following
hierarchy of riskreducing measures This is done with safety warnings.

The ANSI Z535.6 standard describes the following locations in the user manual where this could be
General text general text general text. 3. Do this. This may also be describing special tools or space
for maintenance and repair. These templates contain all legal texts, mandatory disposal information,
copyright statements and comply with the IEC 82079 standard on user instructions. Finding the
right information that solves the user’s problem should take as little time as possible. We call this
version the textual content design. As Philip has a business partner and a developer with indepth
technical product knowledge, I asked Philip to let them review the work so far. Both his business
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partner and the developer provided feedback. Philip used this feedback to optimize the user manual.
Action Send the draft version of the user manual to anyone within your team who might be able to
deliver feedback. Ask them to combine all feedback into one document before sending it back to you.
This stimulates discussion of your team members and prevents disagreement at a later stage. This
means that any images can now be created and added to the content. As images should support,
replace, or augment text, you want to wait to create them until the texts are final. Often, photos are
not as informative because they contain too much information. Besides that, photos can make a user
manual look messy. The content needs to be put into the InDesign template. This is called Desktop
Publishing. If you decided not to use the InDesign template but stuck to the Word file, then you can
skip this step. This could be a translator who is experienced in translating technical content, with
similar products or with translating user manuals. Alternatively, you can do this yourself, of course.
That can be printed, or used online or ondevice. However, as of April 2016, the instructions of many
product groups may be delivered in a different format rather than in print. There is one exception,
however.

Besides that, upon request from a consumer, a paper user manual should be made available to the
consumer. Here he can add videos as well. And by optimizing the HTML version for search engines
he makes it easier for his user to find information for his user That’s how Philip created a compliant
user manual with help from the User Manuals Template and the other available tools that I provided.
We have developed user manual templates for machinery, toys, medical devices and electronics that
contain all legal content. Topics include formatting page numbers, using chapter templates,
footnotes, images, and figures. While we do follow the requirements from Rackham’s formatting
guidelines to demonstrate the tools, in the end, you are responsible for verifying that your document
meets the requirements that Rackham sets. Many of the correct settings are already included in that
document. Frequently switching between Mac and Windows can sometimes introduce odd problems.
Deleting these can affect Style formatting, page numbering, and other aspects of your document.
The bulk of this document revolves around the use of styles.Please verify this template formatting
with formatting guidelines found in Rackhams Dissertation handbook. Topics include formatting
page numbers, using chapter templates, footnotes, images, and figures. Topics such as special
pagination for the front matter or landscape pages and combining documents are also included. Call
ahead 6477406 or visit this link to make an appointment. Depending on the project, it might be
dozens or even hundreds of pages long. When a document is this large, it can be difficult to
remember which page has what information. Fortunately, Word allows you to insert a table of
contents, making it easy to organize and navigate your document. It lists each section in the
document and the page number where that section begins.

A really basic table of contents might look like this And if you ever decide to rearrange your sections
or add more information, youll have to update everything all over again. However, with the right
formatting, Word can create and update a table of contents automatically. Styles also serve another
important purpose adding a hidden layer of organization and structure to your document. When you
insert the table of contents, it will create a section for each heading. In the table of contents above,
each chapter uses a heading style, so there are four sections. Once youve applied heading styles, you
can insert your table of contents in just a few clicks. Navigate to the References tab on the Ribbon,
then click the Table of Contents command. Select a builtin table from the menu that appears, and
the table of contents will appear in your document. Sections that begin with a Heading 2 or Heading
3 style will be nested within a Heading 1 style, much like a multilevel list. Just hold the Ctrl key on
your keyboard and click to go to any section. Just select the table of contents, click Update Table,
and choose Update Entire Table in the dialog box that appears. The table of contents will then
update to reflect any changes. If you want even more control over how your table of contents
appears, check out this tutorial from Microsoft on Taking a Table of Contents to the Next Level.
Although the concept of manuals usually applies to beginners, they can also prove helpful for



persons familiar with the performed task. It would allow uniformity in achieving the desired goals.
Basically, a manual is a book of instructions designed to improve a performed task. Contents 1
Training Manual Templates 2 Elements of a Training Manual Template for Employees 3 Training
Manual Examples 4 Benefits of Using a Training Manual 4.1 Reduces the Time Needed to Train 4.2
Guarantee the Continuity of a Business 4.3 Standardization of Procedures and Processes 4.

4 Delegating is Made Easier 5 Employee Training Manual 6 Some Tips When Making Training
Manual Templates 7 Serving Training Manual 8 3 Techniques for Making Your Training Manuals 8.1
Gathering and Assembling the Information 8.2 Consider Who Will be Using the Manual 8.3
Evaluating the Understanding of Your Users The use of manuals is not limited only to businesses but
also to all establishments who are involved in methodologies like the military, educational bodies,
and even religious institutions. A new recruit will always require a manual. So does an experienced
individual who is working in a new environment. These training tools can be used to Introduce the
subject matter prior to training Serve as an outline to be followed during training Serve as a
reference of subject matter after training Be general reference document Using these kinds of
manual ensures consistency in the presentation of its content which includes skills, processes and
other information. The manual ensures that performed tasks are always consistent in one form. Such
manuals can also be designed as Workbooks or Textbooks They are provided during training
sessions with basic information, examples, and exercises. Reference Manuals It is readily available
to trainees in providing detailed information on processes and procedures. SelfPaced Guides The
manual is designed to facilitate instructions to trainees even without the help of trainers. Job Aids
Manuals usually always provide detailed instruction to be used in the workplace. Handouts It
provides general information to support done during the training. Involving oneself with activities
relevant to the performed task will further enrich one’s knowledge and experiences. This makes it
easier for one to deal with future predicaments. Training does not end with the manual. It goes
beyond that. Training based on manuals in only an event, a beginning. But the importance of the
manual should never be neglected.

It is the cornerstone for making new employees ready to work. It has become an integral part of the
training process. In analogy, it is the new employees ABC, their basic reference guide. When
designing a template, take into accounts to establish a powerful core yet still flexible enough to
serve varied functions and still providing a personal user experience. A good manual should include
these following basic elements The Introduction This part should be concise, attractive and clear and
should provide directly to new users the main purpose of the particular training program. The
Instruction The instructions are crucial as they would give the directions to the user how to navigate
through the varied parts of the training program. Providing the feature at the start would
immediately catch the interest of the trainee at the same time empower them to independently
navigate through the manual. This would at most give them a personalized training experience to
match their individual learning styles. The Objectives With the necessary instructions on how they
navigate through their training program, the next step is to introduce them to your objectives. With
these clearly defined objectives goals and targets presented at the onset, the new employees can
now navigate through the program. They will be transitioning from just trainees to new roles. The
Content of the Manual This element will now define the heart of the material. The content of each
manual will vary from program to program. Bear in mind that the contents are not static. In other
words, the manual can use other forms of media like videos and images to maximize the deliverance
of the content. This is extremely beneficial to the learning process. It may be independent so as to
decide on its form. But it is a critical element it will determine the effectiveness of your program. It
would also demonstrate if the trainees can effectively apply what they have learned.

The second part of this is the importance of surveys as it would allow user feedback at the same time
would serve as a gauge to trainee progress. It would shed light on where the program would need



improvements. The Summary and Some Follow Up Steps Summarize the main points of the booklet
in the most succinct way. You should include followup steps that would improve the ability of the
users to reinforce what they have already learned. Lastly prepare the trainees to the next manual of
the program, if any. A Timeline or Schedule Trainees have the option to organize their own time and
pace themselves, for some kinds of training programs. This is more feasible than assigning them
timelines which they may not be able to accomplish. Trainees may not be able to complete their
training module on a rigid timetable. Flexibility should solve the problem. There are cases when
training programs allow these situations and if applicable, they have to be included in the manual
too. Frequently Asked Questions Most booklets now come with a list of FAQs. This would allow the
trainee when confused to search for a solution to his problem. A great time saver. Any Related
Sources or Supplemental Material If applicable, include any resources related to your training
program as well as supplemental material. This would give the trainees more information about
what they are learning. These days technology is everywhere but concrete manuals are still very
much essential. The design of your training manual template should include programs tailor made to
the different learning habits. It provides mostly all the information needed to perform a certain task
with minimal supervision. But this will all depend on the accuracy of the content. It is therefore
imperative that for processes to go smoothly with maximum benefits, the manual should be
researched and written well.


